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Notes About Membership

Workamper® - Workamper.com®  are registered trademarks of Workamper® News

Intro Account

Diamond Members

Platinum Members

Gold Members

Throughout the book, we’ve labeled the pages with the following colored 
circles so you can quickly tell if the section will be accessible to you.

To extend or change your membership, login to www.workamper.com 
and click on the Renew/Upgrade link on your Dashboard.  

Or contact the WKN office.

When your membership expires, you are reverted to being an Intro 
account-holder to retain your contact information and login info so it is 
easier for you to renew your membership.

what the Gold level used to be 
prior to January 2019

Auto-renew your membership also available! You can turn this on/off 
on the Manage Account page or when joining/renewing.

Former “Dreamer” level members who paid the $42 investment on the 
old (blue colored) website, can still activate a bonus one year Diamond 
membership at any time. There’s a special button on your Dashboard 
when logged in at Workamper.com

If you purchased a lifetime membership when it was available, you 
are a Platinum level member.
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Pricing and benefits subject to change. U.S. funds only. 
Outside the U.S.? - add $6 (Diamond & Platinum only). 

Workamper 
Membership Overview



Workamper.com
www.workamper.com

Our website includes 
information and resources 
to help you learn about the 
Workamping lifestyle and 
make it successful, plus the 
tools you need to find jobs 
and get employers to find 
you.  Education and research 
will help you acquire the 
right position for you.

• Resume Builder
• Hotline Job ads
• Online magazine
• Member Map
• Employer Tours
• Praise Your Employer
• Article Index
• Situations Wanted Ad Submit
• Media Library
• Workamper Experiences
• Employment Verification

• Featured Employers
• Volunteer Resources
• Workamping FAQs
• Workamper University
• How to Find a Job
• Sample Work Agreement

Main Tools and Features:
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Login with:  email address 
and password created 
when you joined

You can also use your member # in place of 
your email address.
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You can update your account 
details easily online!  First, log 
in to Workamper.com which will 
take you to your Dashboard.  Then 
click on the MANAGE ACCOUNT 
button in the top right.

On your Manage Account 
page, click on any of the edit 
links to make changes to your 
information. Be sure to click on 
the save button at the bottom.

You can save a new password 
here, or you can also reset your 
password before logging in - click 
on the Reset Password button on 
the login page.

You can also call the office (800-446-5627) to make any 
changes of your addresses or passwords, or send an 

email to support@workamper.com

- Mailing Address
- Email Address
- Website Log In Password

How Do I Change My...
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These resources will provide you with as 
much information as possible to assist you 
in learning, investigating and evaluating 
your ability to begin and maintain the 
Workamping lifestyle, along with support 
and perspectives to help you begin 
Workamping on the right foot!

Workamper Short Course: We go 
through 101 questions, or derivatives 
of questions, that have been asked over 
the years by individuals considering the 
lifestyle. You may not be able to answer 
all of the questions, so don’t feel bad. 
Some of the questions are asked to help 
you understand that there are many 
considerations to be taken before jumping 
into this lifestyle.

Workamper Boot Camp:  You will have 
your eyes opened to the possibilities of 
the Workamping lifestyle and what it will 
mean to your future. You will experience 
a regimen of who, what, why, and how - 
along with development of a successful 
Workamper mindset.

Four Steps to Freedom online course: 
This series will not only assist you in 
understanding the development of desire, 
but will further assist you in making the 
shift that will be necessary for you to 
experience your dream and turn your 
desire into reality.

Dreamer Exercises:  These exercises 
were developed to help you detemine if 
the Workamping lifestyle is right for you. 
They are based on teachings from Jack 
Canfield and his Success Principles - How 
to Get from Where You Are to Where You 
Want to Be.

• Workamper University

• Magazine Issue Archive
• Media Library
• Article Index

Main Resources:

How do I find them: When 
you log in to Workamper.com,  
you are taken to your 
Dashboard - use the buttons 
here to navigate to main 
resources.

Dreamer-Specific Tools
Education

If you’re embarking on this adventure as 
a couple/team - make sure all of you go 

through these tools!

-- Workamper Short Course
-- Workamper Boot Camp
-- Four Steps to Workamping 
     Freedom Course
-- Dreamer Excercises

Looking for more how-tos? See page 32.
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Member Map Profile 
Connecting With Other Workampers

How do I find it: 
When you log in to Workamper.
com, you are taken to your 
Dashboard.  On your Dashboard, 
click on My Profile.

Why I want to use it:
  • If folks find and click on your  
     pin on the Member Map,  
     they’ll get to see a bit more  
     about you - which can help  
     them confirm they know  
     you or see what you have in  
     common.

You only need to fill out your 
name and address in order for 
your pin to show on the map, 
but your fellow members would 
appreciate it if you shared a bit 
more about yourself!

The Workamper Member Map Profile allows 
you to share a bit about yourself (or yourselves) 
with fellow members! Your Profile will only be 
seen by other Workamper members who click 
on your pin on the Member Map.  The Profile 
is short and sweet, and will just take a few 
minutes to fill out.

There are two important things to note here:

1. EMPLOYERS DO NOT HAVE ACCESS. 
Your Workamper Profile does not need to 
read like your Awesome Applicant resume.

2. YOU DO NOT HAVE TO PARTICIPATE. You 
do not have to have a profile to search and 
view other members’ pins on the Member 
Map, nor to use other tools on the site.

Edit Your Profile.  Click on the Member 
Map Profile button on your Dashboard. 
Type in information about yourself in the 
provided sections. Click the Save button 
when you’re done! The View Your Profile 
button shows how others see your profile.

In addition to contact information, you’ll 
put in an address for your current location. 
And further down you can say what your 
domicile/home base city/state is.

You can mention what RV and tow(ed) 
vehicle you have, plus write up a little 
about me section to share things like 
where you want to travel or have traveled, 
the Workamping job you’re doing at your 
current location, travel companions, 
hobbies/interests, etc.!

Your profile is only viewable by fellow 
Workamper members, it is not open to the 
general public.
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How do I find it: 
When you log in to Workamper.com, you 
are taken to your Dashboard.  On your 
Dashboard, click on Member Map.

Update and use often! Move your pin 
on the map as you travel. You can edit 
your pin location via the Member Map 
Profile page, or you can edit it right in the 
Map tool by clicking the edit my pin link.

A big benefit of this tool is you can 
research a Workamping job/employer. 
Search for the city, state of a job you’re 
interested in.  See which Workampers are 
located there. Contact them to see if they 
are working with that specific employer.

Click on a pin to see who it is and then 
click on “View Full Profile” link for any info 
they’ve shared.

You can use the fields in the sidebar to 
search on things like name, city, and state. 
Any results will display in a table beneath 
the search. You can click on a name to go 
to that person’s pin. 

Click on the Reset button to start your 
search over and go back to seeing all the 
pins on the map.

Using the Map

Member Map
Connecting With Other Workampers

Why I want to use it:
  • Find fellow Workampers in your  
     immediate area.

• Search and find your Workamper  
   friends.  See where they are and  
   contact them to say hello!

• Research a potential Workamping  
   position. Search for the city, state  
   of a job you’re researching. See which  
   Workampers are located there. Contact  
   them to see if they are working with  
   that specific employer.

Employers do not have access to the map. 
You can search the map without having 
to share your location/add your pin.



10

Once you create and save your online 
resume it will be added into the database 
that is searched by our Employer 
members.  They will contact you directly 
if they are interested. And you can easily 
email your AA resume to Employers you 
are interested in.

You can create and maintain your 
resume using the Resume Builder. There is 
a section for you to enter your Availability 
Date, so you can keep your resume active 
in the database all the time. There is also 
a box you can check to have your resume 
hidden from the database. Employers can 
sort their search results by availability 
date and by the date you last edited your 
resume, so be sure to update often!

If you are a couple/team, you will 
include everyone on one resume.

The Resume Builder is a step-by-step 
tool. You will see each step in a tab along 
the top. On the Home tab (Tab 1), you will 
see a button to email your resume and 
print your resume if you need to mail or 
fax a hard copy. You can also export your 
resume as a PDF file which can be emailed 
or used in an application process requiring 
you upload your resume.

Also shown is how many times your 
resume has been viewed, and when your 
resume was last updated. The Preview 
button will show you how Employers will 
see your resume.

As you are creating or editing your 
resume, remember to CLICK THE SAVE 
BUTTON ON EACH PAGE before moving 
to the next section. If you do not click the 
Save button, you may lose any information 
you just entered.

How do I find the AA Resume 
Builder?: 

• When you log in to Workamper.com,  
  you are taken to your Dashboard.   
  On your Dashboard, click on Resume  
  Builder.

Why I should make and update my 
resume: 

• Works for you 24/7/365

• Email your resume to anyone (and it  
   logs each send)

• Easy, step-by-step tool to create and  
   maintain your resume

• Employer members can search the  
   database to view and save resumes

Awesome Applicants Resume
Put Yourself Out There

The AA Resume Database is not open to 
the world. Only Employers who invest 
in a membership have access to search 
the database and view resumes. When 
communicating with an Employer, it would 
be best to email your resume to them instead 
of asking them to search for it - it will be less 
work for the Employer, and the Employer may 
or may not have access to the database.



Tab 2 - Applicant. Enter your contact 
information, additional info on best time/
way to contact you, and your RV type and 
length.

Tab 3 - Availability.  This section should 
be updated as soon as you have taken a 
Workamping job. Enter in the next date 
that you are available for and what season.

Tab 4 - Settings. Select the types of 
businesses you are interested in, salary/
benefits and schedule preferences.

Tab 5 - Locations. Select the U.S. states 
and Canadian Provinces you would like to 
work in. Please don’t select a state unless 
you really will work/live there starting on 
your Availability Date.

Tab 6 - History. Create an entry for each 
of your previous Workamper experiences. 
If you’re a couple, you can do one entry 
per experience and include both of your 
positions.

If you are a Platinum member, you have 
the additional bonus of requesting to have 
each of your History entries verified by 
WKN. Check the box, enter the requested 
info, and submit. WKN will contact the 
employer to verify you worked there 
during the dates you entered. Having 
verified references done by a third party 
helps you stand above the rest!

If you want to list references for 
Employers to contact directly, type that 
into your Sell Yourself section.

Tab 7 - Sell You. Type up a few paragraphs 
about you (and your partner), what you’re 
looking for, your skills, etc. You can type up 
this section in a word processing program 
so you can have it saved on your computer.  
To copy/paste in your text, please click on 
the button in the editing toolbar that has 
a small clipboard and letter W icon. Paste 
your text into the window that opens, 
and then click Insert. Then use the editing 
toolbar to add formatting like bolding, 
bullets, etc.
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To spellcheck your text, click the “ABC” 
with checkmark button in the editing 
toolbar. You can change words based on 
the checker’s suggestions or ignore them.

Tab 8 - Photos. [optional] You can have 
up to three photos. We recommend a 
close up, a photo of you in front of your RV, 
and a photo showing your entire RV (with 
tow/towed vehicle too if you have one).

The upload tool will automatically re-
size the photos for quick-viewing. If you 
are using a mobile device, you should be 
able to select photo files from the photo 
library on your device.

If you have trouble and your photos will 
not upload, try re-sizing your photos to be 
smaller before uploading if possible. For 
assistance, contact WKN.

Click on Choose file to find a photo 
where it is saved on your computer. Click 
on the Upload button and once one photo 
uploads successfully, you’ll have the 
option to upload another.  You can remove 
any photo you’ve uploaded, and you can 
change the order of your photos by clicking 
on a photo and dragging it above or below 
another photo.

Tab 9 - Video.  Create an “icebreaker” 
video. Record yourself(selves) introducing 
you and giving a quick overview of what 
you can offer to the Employer. This allows 
an Employer to get a better feel for who 
you are - better than what just text and 
static photos can do.

Upload your video to YouTube or other 
video-housing service. Copy the shareable 
link to the video and paste it into the 
field here. This will then display your 
“icebreaker” video below your photos and 
above your Sell Yourself text.

-------
We recommend updating your resume 

every other month. Any resumes that have 
not been updated within SIX MONTHS 
will be hidden from employer searches.
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Situations Wanted Online (SWO)
Put Yourself Out There

Members can “jump up and down” in 
front of Employers and share why they 
would be a benefit to them by posting an 
online Situations Wanted Ad (SWO).

When you submit your SWO ad, it 
will  be displayed to Employer members 
logged in to the website for 2 months. (If 
you need your ad removed sooner, just 
email/call the WKN office.)

Your online ad can be up to 75 words. 
Describe your skills, where you want 
to be, when you want to start, and if 
you have any specific needs. Be sure 
to include how you want Employers to 
contact you. You can also check a bubble 
to include a link to your AA Resume (the 
link is generated for you automatically).

Use the online form to submit your 
SWO ad. You will receive an email 
confirmation once your online SWO ad 
is posted (your ad goes into our admin 
tool and we’ll look over it before making 
it active).

You can view your submitted SWO 
ad too. When you are logged in to 
Workamper.com, go to the Situations 
Wanted Ad Submit page and you’ll see 
a link for “Your current SWO”. This page 
will show your current SWO online ad, 
as Employers see it. If you need to edit 
your SWO ad, copy the text, go back to 
the SWO form, paste your ad text in the 
box and make any changes and submit.

You can run one SWO ad at a time, as 
often as you like throughout the year.

On your Manage Account page, you 
can view your SWO and SW print ad 
history.

Your Awesome Applicants Resume number is 
your member number. Employers can find your 
resume searching on your number, your name, 

or your email.

SW Online ads can have up to 75 words. 
Ad runs online for two months. 
Re-submit any time to update. 
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Hotline Jobs Daily Email
Find A Job

The main avenue for viewing Workamper opportunity listings is the Hotline. Each 
weekday, Employers submit Hotline ads. Once we receive and process an ad, it is 
immediately posted to the Hotline Jobs website page at Workamper.com (which we’ll 
talk about on the next page).

At 4 p.m. CT, our system compiles the day’s Hotline ads into an email and sends it 
out to members. The Hotline email is sent to you from hotline@workamper.com 
Please put this address in the address book/safe senders section within your personal 
email account to help ensure deliverability.

The Hotline Daily email preference will automatically be turned on for you when 
you become a member. You can turn the preference on/off via Manage Account page.

Please note:  There is no Hotline ad archive available on our website.  But, you can 
create your own archive by creating a folder in your personal email program, and 
putting the emails in there. Then use the search option within your email program if 
you are looking for a past ad with specific criteria.

The ads you see are based on your member level:
Diamond & Platinum -

New ads posted same-day

Intro - Ads posted 14 days ago

Gold -
Ads posted 7 days ago

Hotline Job Alert Emails
How do I find it: Emails are sent to the 
email address on your membership.

Why I want to use it:
  • Quickly review new opportunities;  
     don’t have to go to a website

  • Geo-targeting available. Receive ads for  
      only the states you’re interested in!  
      Select your states after turning ON the  
      Job Alert email option.

To turn Job Alert emails on/off, click on 
the Manage Job Alert Emails button on 
the Dashboard, or click the link in the 
Communication Preferences section on  
the Manage Account page.

D&P Members Only: If you are in “job 
search” mode, the Job Alert Emails are a 
feature you will want to take advantage 
of. Be one of the first to know about 
the new, available positions!  As soon as 
we publish a new Hotline ad (anytime 
between 8 a.m. and 4 p.m. CT), you can 
receive an email containing that new ad.

Via the Manage Job Alert Emails button 
on the Dashboard or the link on your 
Manage Account page, select the states 
you are most interested in to receive Job 
Alerts for just those states. You can also 
still receive the main Hotline Jobs email 
in the evening containing all of that day’s 
Hotline ads.



Hotline Jobs Website Page
Find A Job
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Search on:
• State location the job is in  
   (select one or more states)
• RV site available
• Other housing available
• All hours paid
• Other compensation available
• No monetary compensation  
   (if you’re looking for just a  
   tradeout for RV site)
• Job start date  
   (select immediately or any  
   months)
• Solos considered
• Keyword

Sort the ads by:
• State location the job is in
• Date published

Not only do we provide the most information with our Workamper help wanted 
ads, but we also give our members the most search capabilities to narrow down the 
posted opportunities to the ones that are a closer match to their preferences.

Each weekday, Employers submit Hotline ads. Once we receive and process an ad, 
it is immediately posted to the Hotline Jobs website page at Workamper.com.  These 
are the ads that are included in the Hotline Jobs Email and Job Alert Emails that we 
discussed on the last page.

The website page displays only the Hotline ads that were published within the last 
14 days, so you know you are always looking at the most recent opportunities. Each 
ad displays a published date.

When an Employer is submitting their Hotline ad, they are required to fill out some 
general information fields. The information they include is displayed with their ad and 
enables members to more quickly search and see if an opportunity may be a match.

We have 10 different search criteria options plus 2 ways that a member can sort 
their search results. By default, the ads are shown to you with the most-recently 
published ad at the top.
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How do I find it: 
When you log in to Workamper.com, 
you are taken to your Dashboard.  On 
your Dashboard, click on Hotline Jobs

Why I want to use it:

  • New job listings each weekday

  • Organize opportunities quickly by  
     searching on 10 different criteria

  • Links to learn more about an  
     Employer

Note 1: 
Employers write their own help 
wanted ad text and determine 

what contact info to share. Only a 
few Employers elect to create an 
Employer Tour and/or Featured 

Employer page.

Note 2: 
If the advertising Employer has 

existing Workamper Experiences 
posts or PYE star awards, you will 
have direct links to access them. If 

nothing exists for that Employer yet, 
these links won’t display.

Note 3: 
Multiple Locations -- Be sure to 
check this “state” section too! 

Multiple Locations is for Employers 
that have opportunities in more 
than one state.  The location you 
are seeking to be in may be here! 
Also, Employers who offer remote 
(not location-dependent) jobs are 

included here too.

Hotline Ad Features

State Location

Details 
on the

opportunity

Contact
Info

More
Details

Link to photos

Links to reviews
and Workampers
who worked there



Workamper News Magazine
Find A Job

• Details on a Workamping experience/job
• Creating a Workamping resume
• Solo Workamping
• RV maintenance
• Types of RVs
• Tips for finding the right job for you
• Workamping with pets
• Different types of Workamping jobs
• How to get started Workamping and RVing
• Things to see/do in different U.S. regions
• Handling the weather in an RV
• What to do when you want to hang up the keys
• Operating a small business on the road
• and many more!

Some of the topics covered in our magazine:

Workamper® News magazine was published 
bi-monthly (six times a year) until 2022. The 
magazine contains Workamper Opportunitiy 
listings (generally for the next season or year-
round positions), plus articles on Workamping 
experiences, RVing & Workamping resources, 
Classified ads, Staff Corner, informational columns 
and more!

All member levels can view all 100 issues in the 
archive! Login to Workamper.com and go to the 
Online Magazine page to open and view the issues.

The online version is a PDF file file that you open 
and view in your internet browser.  You can go 
through every page, zoom in/out, save the whole 
thing to your computer, print any page, and do 
keyword searches. You can go online any time of 
any day to view an online issue.

On the issue archive page, click in the box of the 
issue you want to open. We recommend reviewing 
past issues for Workamping opportunities and 
other helpful info.
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Why we use PDF:
  • Opens faster on slower  
     internet connections
  • Best zoom capabilities
  • Device compatibility

Add the issues to the Files 
app on your iPhone/iPad 
for easy review/access. 
Other mobile devices 
usually have a Kindle 
app or other app where 
you can store PDF files 
and access them on your 
device without having to 
go our website.

Mac users, you can also 
use Preview to view an 
issue.

• Most internet browsers support this file type and open it easily
• When you save the file to your computer, you’ll need to have a program that  
   can open PDF files, like Adobe Acrobat Reader (free) or Preview (Mac).

Save file to your computer so you will not need to go 
to the internet next time you would like to open it. On 
the issue archive page, right click on the PDF link then 
select “Save Link As…” – in the window that appears, 
select the location on your computer where you want 
to save the file to, rename the file if you want to, and 
then click the Save button. If you already have the file 
open, go to File -> Save As.

Below are some things you can do once you have 
the magazine open. Most of these options are located 
in the toolbar, and the toolbar location is dependent 
on your internet browser (you may need to put your 
mouse over the lower center of the page or lower right 
to get it to appear) and device. 

Most of these options/buttons exist when you have 
the PDF file open in a program on your computer like 
Adobe Reader.

Zoom In/Out.  You can zoom in to get a closer look 
or make the text larger for reading. Use the + and - 
buttons or hit Ctrl then + on your keyboard to zoom in 
and Ctrl then - to zoom out.

Keyword Search. If you have a stationary toolbar, you 
may see a box with the word Find or Search in it. This 
will search all the pages and allow you to click through 
the pages that have that keyword on it. You can also hit 
Ctrl then F on your keyboard to bring up a “find” box.

Print. Click on the Printer icon, or go to File -> Print.
Jump to Pages. If you know of a specific page you are 

looking for, you can type in that page number in the 
box next to the  /60 and then hit Enter.  Or, you can use 
the arrows, usually pointing up and down, to click up a 
page or down a page - one page at a time.

How do I find it: 
When you log in to 
Workamper.com, 
you are taken to your 
Dashboard.  On your 
Dashboard, click on 
Online Magazine.
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The Online Magazine is a PDF file

All member levels can access the entire online issue archive!

We encourage you to review opportunities in past issues - you never 
know when an Employer will have open Workamper positions!
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More Opportunities
Find A Job

How do I find it:
Go to 
www.workamper.com/FE

- Or at Workamper.com, 
mouse over the Workamping 
menu item, then click on Job 
Resources.

- Or click on the changing 
banner on the left side of 
your Dashboard.

- Or click on the Featured 
Employers button on your 
Dashboard.

How do I find it:
Go to 
www.workamper.com/
volunteer

- Or at Workamper.com,  
mouse over the 
Workamping menu 
item, then click on Job 
Resources.

How do I find it:
At Workamper.com, mouse 
over Job Resources. Pages 
can also be accessed via 
buttons on the Dashboard.

Employers who have opted to share more about their 
Workamping opportunities are Featured Employers. 
The Employers who select this ad option create a 
website page with information, images, and sometimes 
video, to help you learn more about what they have to 
offer Workampers.

At www.workamper.com/FE you will find the list and 
a brief description of all the Featured Employers. Click 
on the Featured Employer Page box that displays below 
the logo image to view that Employer’s page.

The contact information will be included on their 
page, and there may also be info on their application 
process.

Visit this page often as new Featured Employers may 
come on board throughout the year!

The idea of giving back to communities, the nation, or 
particular humanitarian organizations motivates many 
RVers to volunteer for Workamping jobs. Volunteering 
is an American tradition that provides immeasurable 
contributions to society on both a national and 
community level.

In this section you will find articles providing 
information and Workampers’ perspectives on 
volunteering, along with opportunities at non-profit 
orgs that have been submitted to Workamper News.

There are a few other pages on our website that will 
describe some Workamping Opportunities:

- Jobinars - video by an Employer describing their jobs
- Media Library videos*; articles in the Article Index*
- Banner ads at Workamper.com

Featured Employers

Volunteer Resources

Additional Opportunities

There’s still more!There’s still more!

*Gold, Diamond, Platinum members only.
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Employer Tours
Researching an Employer

This tool is a great starting 
point for when you are 
researching an Employer you 
have interest in working for. The 
Employer Tour provides a visual 
introduction to the Employer’s 
location and environment they 
provide.

Employer Gold members to 
WKN can create an Employer 
Tour, which includes a 
description, their logo, and 6 
photos with captions.

We encourage Employers 
to upload photos that show 
off the working and living 
environment at their location; 
i.e. if it’s an office job, show 
behind the desk, and show an 
RV site so you’ll have a better 
idea if the environment would 
be right for you.

When you come to the 
Employer Tours page, you’ll see 
a list of all current Tours. You 
can sort the list by clicking on 
the column headers - Employer, 
City, State, Category. Click on 
the name of the Employer to 
open that Tour.

When viewing a Tour, click on 
a picture to see a larger view of 
it and the caption (if provided). 
Use the arrow buttons to switch 
between the photos.

Click on the back to employer 
tours button to go back to 
the full list of Tours. We hope 
this tool will come in handy, 
especially if the Employer does 
not have a website.

How do I find it: 
When you log in to Workamper.com, you are 
taken to your Dashboard.  On your Dashboard, 
click on Employer Tours.

Why I want to use it:
  • Brief description of the location/environment

  • Pictures (hopefully) showing off the living and  
     working environment you would experience

  • Good starting point when researching your next  
     potential Employer



Praise Your Employer (PYE) is a tool 
where all the info comes from you, the 
Workamper!

When you are researching an 
Employer, search for them in PYE to 
see if other Workampers have had a 
positive experience with them in the 
last 2-3 years, and then contact those 
Workampers for more info.

Search for an Employer by company 
name, city or state. Type in the 
company name or city or select a 
state, and click on the Search button. 
You can also sort the list by clicking on 
the column headers - Employer, City, 
State. In the main display, it will show 
you the Employer name, any stars 
awarded and the date the last star was 
awarded.

Click on a red star award to 
(possibly) see the email address of the 
Workamper who awarded that star. 
Then click on the email address to 
send that Workamper an email with 
a request to share more info.  In your 
email, please try to ask some specific 
questions and include your name and 
email address so they can more easily 
reply to you.

Not finding the employer you 
are researching in the list?  Check 
the spelling or try searching just on 
the city or state as a Workamper 
awarding a star may have spelled the 
name incorrectly. Or, this may mean 
it has not been a positive experience 
for others, but please be sure to do 
thorough research!

Praise Your Employer
Researching an Employer

When in Research Mode
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How do I find it: When you log in to 
Workamper.com, you are taken to your 
Dashboard.  On your Dashboard, click on 
Praise Your Employer.

If the employer has been awarded any 
stars, a link to PYE will be included with any 
Hotline ad the employer runs too!

Why I want to use it:
  • To see if any Workampers had a positive  
     experience with the Employer you’re  
     researching.
  • Contact the Workamper(s) who posted  
     the star(s) to ask them specific questions  
     about the experience.
  • Award a star to an Employer you had a  
     good or great Workamping experience  
     with.

Hotline Ad 
Example



The other side to the Praise Your Employer tool -- Award a star to Employers you had 
a good to great Workamping experience with.  You can award a star to an Employer 
that you have worked for within the last two years.  Remember, the more folks utilize 
this tool, the stronger it will be when you’re on the research side, so please participate.

Award Your Employer
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First - Search to see if your Employer 
already exists in the PYE database.

If your Employer is not yet listed - Click on 
Add Employer & Star Award button.

Notes:

If you find your Employer, click on Add Star Award link in the row for that 
Employer. Select the year you worked for them; check or un-check the box 
saying it’s okay for other Workampers to email you with any questions, and then 
click the Save button.

Type in the Employer’s Name 
(company name) and city, then 
select the state, the year you 
worked for them, and then check 
or un-check the box saying it’s 
okay for other Workampers to 
email you with any questions. 
Click the Save button to submit 
your award.

If you would like to Praise Your Employer, but don’t really want to be contacted by other 
Workampers with questions, that’s okay! Just keep the ‘It is ok for others to email me’ box 

unchecked when awarding your star. Please still submit your star award to continue the 
expansion of this tool for you and your fellow Workampers.

Star awards only reflect the last 2-3 years.
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Workamper Experiences
Researching an Employer

How do I find it: 
At Workamper.com click the Workamper 
Experiences button on your Dashboard.  
Or click the Workamper Experiences link 
whenever it’s included with a Hotline ad 
in the email or website page.

Why I want to use it:
  • Read about other Workampers’  
     experiences with the employer you’re  
     researching.
  • Request info about an employer if  
     there’s nothing yet posted.
  • Share your experience with other  
     Workampers to help them out in  
     their future job hunting.

You can do searches, 
and view all of the 
posts you personally 
have made. Your 
posts can be edited or 
deleted at any time. A 
date shows with every 
post, and posts may 
or may not have the 
name/email of the 
poster. The poster has 
the option to share 
just his/her member 
number to remain 
anonymous.

Posts can be positive (POS), 
negative (NEG) - or both - or 

be a warning (WRN), or asking 
questions (INF).

Since 2007, Workampers have been 
sharing about their Workamping 
experiences within the WKN website 
system. THIS IS A VERY VALUABLE 
TOOL that takes Diamond & Platinum 
membership to yet an even higher-
level. And, it’s connected right to 
Hotline ads - along with a link to any 
Praise Your Employer stars.

In newer issues of our magazine, 
when you see a hand-holding-a-pencil 
icon at the end of the ad text, that 
indicates that Employer has a topic 
in the Workamper Experiences (WE) 
section.

Also, when you view a Hotline ad 
in the email or on the website page, 
if that Employer has a topic in the WE 
section, you will find a direct link right 
to it.  Between this and the PYE stars, 
we’re giving you very easy access to 
Workampers who have “been there, 
done that.”

Plus, since this “review” tool has 
been in existence for so long, you’ll find 
more information here than you will on 
any other website or Facebook group. 
And it’s only going to get bigger!

Searching the Workamper 
Experiences (WE) tool should be one 
of your steps in researching a potential 
Employer. And, once you finish a 
Workamping position, please be sure 
to share about the experience.

Your fellow Workampers have taken 
the time to post about the experiences 
they have had, and we hope you will 
do the same to further the usefulness 
of the Workamper Experiences tool.
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When in Research Mode

When you come to the WE tool, please 
read through the instructions, and then use 
the links at the top to navigate. 

Click on View Company Listings to search 
and see if your employer is already listed. 
The topics, by default, are sorted so that 
the topics at the top of the list have the 
most recent posts. Use the fields provided 
to search the list, or sort by clicking on the 
column headers.

If you find an existing topic, please post 
within it. If not, please click the link to Add 
Company & Post. You have the option to 
share your member number, your name, 
your email address or all of the above with 
your post.

Any topics or posts made in the 
Workamper Experiences tool must be 
approved by an adminstrator before the 
post will appear live on the site. You will be 
sent an email if your post is disapproved 
with recommendations on how to revise 
your post so it can be published.

Share YOUR Experience

WE is an avenue for Workampers to 
share about their experience with a 
specific Employer. Posts are made by fellow 
Workampers, and remember, what is right 
for one may not be right for another so 
read, ask additional questions, and do an 
individual evaluation of the info presented 
and the poster of the info.

A post can be about a positive, negative, 
good, or not-so-great experience. Start by 
clicking the View Company Listings link. Use 
the provided fields to search to find out if 
there is an existing topic on the Employer 
you’re researching.

If there is an existing topic, click on the 
employer name to go into that topic to 
view the posts within it. If you’d like to add 
to the discussion or ask questions, you can 
use the fields toward the bottom of the 
page to add a post.

If not, you can create a new topic asking 
for information; click on the Add Company 
& Post link, fill out the required fields, then 
click the Save button.

Post titles include the feeling of the 
experience - POS (positive), NEG (negative), 
WRN (warning) - as well as the state and 
the employer name, so it’s easy to quickly 
identify the general feeling of the poster.

• All posts made will be reviewed by an administrator before being published.
• Poster has the option to show name/email address/member number with a post.
• It is on you to post the truth as you experienced it
• Employer members have access and can post as well.
• If a company has an issue with a Workamper’s posting, they are welcome to  
   post a reply.
• Workamper News staff will not play “middle man” to mediate nor will we  
   participate in “he said/she said” phone calls or emails about these postings.
• Please wait untill AFTER you have finished the position/season to post your  
   experience.
• Your post may only include your personal experience. Second-hand information  
   will be edited out or disapproved.

At the discretion of the Workamper who 
posted the experience, he/she may have 
elected to show their email address with 
their post. You can then contact them 
directly with any questions you have.
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Platinum-Only Benefits
Taking It to the Next Level

Since Platinum members strive to be 
the best Workampers they can be and 
make the most of their RV & Workamping 
lifestyle, we offer you special discounts!

Click on the Platinum Discounts button 
on the Dashboard to learn the details and 
how to redeem.

Workamper News will verify your past 
Workamping jobs from the last two years 
on your Awesome Applicants Resume.

You will submit a request to us to verify a 
Work History entry on your resume. We will 
then contact the Employer via the contact 
info that you provide us. We will confirm 
with the Employer that you worked for 
them for the time frame that you entered.  
If the Employer confirms this information 
to be true, that entry in your Work History 
section will show “Verified: Yes.”

Employers are regularly searching our 
Awesome Applicants Resume Database to 

help fill their staffing needs.  Employers usually prefer to see work history or references on 
resumes.  If this information is already on the resume, the step of having to request this 
information from the applicant is removed.

Then, taking that a step further, showing that these Work History entries have been 
verified by a third party - well, that’s basically a shining star on your resume.  It is more 
likely that you will be contacted because you have taken the extra time to save the 
Employer some time.

Our Employer members have different criteria fields in the resume database that they 
can use to narrow down their results. One of the criteria is a checkbox to only show 
resumes that have verified Work History entries.  You want your resume to show up as 
often as possible, so having verified Work History entries will help insure that happens.

This is all done in the Resume Builder tool.  Go to the History tab/section of the Resume 
Builder.  Here is where you add your previous Workamping jobs and where you’ll check 
the box to submit a request to verify an entry. Note - It may take WKN staff up to a few 
weeks to get these verified since it requires direct communication with the Employer.

Special Discounts

Employment Verification

• Discounted event pricing  
   (like our annual Rendezvous in October)
• 15% discount coupon for the WKN Shop
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Facebook Page & Group
Connect & Share With Your Fellow Workampers

Follow Us Anywhere!

Employment Verification Link to our page via 
the Connect menu item 
on our site or search for 
Workamper News on 

Facebook itself.
“Like” our page to see our posts in 

your News Feed. We are frequently 
posting information regarding the 
Workamping and RVing lifestyle and 
the best resources to help you find 
success.

We’ll also post announcements, 
upcoming events, photos, and links 
to other great resources to help you 
succeed at this lifestyle.

Please also write a review and share 
your experience with Workamper 
News so far!

Workamping Today Facebook Group: Our 
Workamping Today Facebook group is active 
and friendly. We’re always chatting, helping 
each other out, sharing the latest tips and 
celebrating each other’s successes in the RV & 
Workamping lifestyle.

You’ll find our group by typing in “Workamper 
News” in the search bar on the top of the 
Facebook website or app. Click the “Join Group” 
button. Open to members and non-members.
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Media Library
Educational & Fun

For years, Workamper News has been 
hosting online webinars to provide 
information, education and a connection 
to the experts of the Workamping world.

We’ve recorded these webinars and 
organized them in the Media Library 
for you to watch at your convenience. 
Immerse yourself in the lifestyle and get 
answers to questions you have, or would 
have never thought to ask!

Scroll down the page to review all of 
the different videos available. Click on the 
orange title of a video to go to the page to 
watch that video.

You can sort the videos using the menu 
on the left. Sort by Category (subject/type 
of webinar), Topic, Presenter, Type, or 
search by keyword.

Days of Video
How do I find it: When you log in to 
Workamper.com, you are taken to your 
Dashboard.  On your Dashboard, click 
on Media Library.

Or mouse over the Workamping menu 
item, and select Media Library from the 
drop-down menu.

Why I want to use it:
  • Answers to questions about  
     Workamping and RVing
  • Get to know the experts in the  
      lifestyle
  • Learn about some great Workamping  
     adventures
  • Info to help you make the most of  
     your lifestyle!

Article Index
If you have an interest in working, camping and 

enjoying life - this section is for you. Whether you are 
an experienced Workamper or a curious reader, you can 
find all of your Workamping answers here. Feel free to 
explore the articles we have provided.

Many of the articles are written by former Viewpoint 
Editor, Jaimie Hall Bruzenak.  Some of the articles 
written about a Workamper Experience come from the 
Workampers themselves or the late RVing author, Arline 
Chandler.

The articles are divided into several categories like 
General Information, Getting Started, Job-finding Tools, 
Active Workampers, Workamper Journal, and more.

Click on the orange bar for the section you’d like to 
peruse. Then click on an article title to open and read 
that article.

How do I find it: 
Click on the Article 
Index button on your 
Dashboard. Or mouse 
over the Workamping 
menu item.

Why visit: 
Gain knowledge of 
different Workamping 
experiences, how to 
write your resume, 
RVing tips, and much 
more!

*These articles are in addition 
to the ones we printed in 
issues of WKN magazine. Be 
sure to read both!
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How do I find it: 
When you log in to Workamper.com, 
you are taken to your Dashboard.  
On your Dashboard, click on 
Workamper University.

Online Courses for Workampers
Further Your Workamper IQ

Since 2007, we have 
created online courses 
for Workampers & 
Employers. Each course 
contains videos and 
PDF handouts. You can 
go through the different sections of each 
course an unlimited number of times.

Diamond & Platinum members have six 
courses in their University: Workamper 
Short Course, Workamper Boot Camp, 
Dreamer Exercises, Four Steps to 
Workamping Freedom, and Workamper 
Marketing 101 which will help you develop, 
implement and make sellable your Personal 
Marketing Strategy.

Also, if you purchase an ebook from our 
Shop, the ebook file appear here too!

Workamper 
University

Blog Articles
While most of our content is reserved for our 

members, we do share some articles for the whole 
world to see online.

The Gone Workamping blog website was created to 
share Workamping experiences, how-to information on 
the lifestyle, plus announcements and new resources.

How do I find it: 
Go to
goneworkamping.com

Why visit: 
Even more articles 
and info on the RV and 
Workamping lifestyle.



The Workamper Show podcast strives to build 
your dream of living the RV lifestyle through 

inspiration, motivation, and education.

www.WorkamperShow.comwww.WorkamperShow.com

Presented by Workamper News and produced and 
hosted by Greg Gerber, this weekly show will entertain 
and educate you with the personal stories of people 

that have followed their dream to RV! We also 
interview Employers to get the details on their jobs.

Listen for free on our website or via your favorite podcast listening app

Want to share your story on the show? Send an email to 
podcast@workamper.com to schedul your interview with Greg.


